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Excel

Open Excel
Use menus and toolbars
Input and format data
0 Relative and absolute reference
0 Freeze panes
o Merge cells
o Format cells
Sort and analyze data
o Sorting
o Filtering
Use formulas and functions
Create and edit charts
Insert charts in a Word Document



Getting Started

Open Excel

1. Click on the Start button located on the Task Bar
2. Highlight “Programs”
3. Click on “Microsoft Excel”
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Quick Launch Area

Tip: You might have a shortcut on your desktop or in your quick launch
area to open Excel.

Set up toolbars

The following steps are not strictly necessary, but may be helpful.

1. First goto Tools = Options = View tab. In the Show area, make sure that both
the Formula bar and Status bar boxes are checked (it’s okay if other things are
checked). Then click on OK.

Second, go to Tools - Customize - Options tab. In the Personalized Menus
and Toolbars area, make sure that the Standard and Formatting toolbars will be
shown on two rows. Depending on which version of Excel you are running, this
may require checking "Standard and Formatting toolbars on two rows™ or
unchecking "Standard and Formatting toolbars share one row." Then click Close.



Lakewood School District
Technology Competencies
Excel Skills Tutor

Basic components of your Excel workbook

1. A new Excel document is called a workbook. The workbook may contain multiple

pages or sheets, accessible through tabs at the bottom of the screen.

The individual squares into which data may be placed are called cells.

Columns of cells are identified with letters, and rows are identified with numbers.

4. Combining the column letter and row number gives each cell its own, unique
identification or cell address. The cell address of the selected cell is shown on the
upper left part of the screen, just below the toolbars.

5. Just to the right of the cell address bar is the formula bar, which will be discussed
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later.
”ﬁ Filz Edit ‘iew Insert Format Tools Daka Quickshest Windomw Help
Cell Address DEEEGRY sBR S o A&/
firial v10vBIE|§§§‘$%_
o AL = =] <= Formula Bar
Highlighted A B | ¢ | D [ E [ F ]
cell is the i ——
selected cell. % Cells
4
Rows 5
Begin with 5
9 —| 7
numbers. —
32
[4[4]» M5 Sheet1 { Sheetz £ Sheets /
HD[an [z d| P.gtu:u*apes-ﬁ w [ D‘| &vﬁv &
Ready
Columns begin
Worksheet Tabs with letters.
A Quick Tour

This little tour takes you to the four corners of a Sheet in an Excel Workbook. Starting in
cell A1, hold the Ctrl key down and press the Right Arrow key. This takes you to cell
IV1in Column IV. That means there are 256 columns across. Now hold the Ctrl key
down and press the Down Arrow key. This takes you to cell IV65536. This means that
there are 65,536 rows down the worksheet making the total number of cells 16,777,216.
And that’s only on Sheet 1! There are just as many cells on every sheet that a workbook
contains. Now hold the Ctrl key down and press the Left Arrow key. This takes you to
cell A65536. And then holding the Ctrl key down and pressing the Up Arrow key or just
pressing the Home key will take you back to cell Al. Pressing Ctrl-Home will take you
back to cell A1, no matter what cell is currently selected.
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The Three Little Cursors

There are three different cursors in the cell area of an Excel sheet, each with a different
function.

1. The first cursor is ¢p, the Fat White Cross or Plus sign. This is the Selecting
Cursor. Clicking on a single cell will select an individual cell. Clicking and
dragging on many cells will select multiple cells. If you want to select multiple cells
non-adjacent to each other, click on the first cell or cells, then hold the Ctrl key down
and click on the next cell or cells. As long as you hold the Ctrl key down, you may
continue to select multiple cells that are not next to each other without selecting any
intervening cells. To select an entire column of cells, click on the letter above the
appropriate column. Likewise, if you want to select an entire row, click on the
number of the appropriate row.

A B D
1 Name Quiz 1 Score|Quiz 2 Score|Unit Test Score
2 Alvarez, Bobby 9 6 42
3 Hopkins, Alicia 8 8 45
4 Jones, Richard 7 8 38
S Markova, Natalya 7 10 47
6 Simmons, Dan 8 7 47

2. The second cursor is the Skinny Black Cross or Plus sign (+). If you look at the
bottom right corner of a selected cell or cells, you will see a small black square.
Placing the Fat White Cross on this small black square will change the cursor to the
Skinny Black Cross. This is the Fill Down or Fill Right Cursor. Placing the cursor
on this box and clicking and dragging will continue the pattern established in the
selected cells to succeeding cells below, up, to the left, or to the right of the selected
cell or cells.

Example: To fill a formula down, select cell C1 and type " =A1+B1" then press
Enter. Select cell C1 again and place the Fat White Cross on the small
black square so that it changes into the Skinny Black Cross. Click and
Drag down to cell C5. The formula will be filled in those cells but the cell
reference will change. Click on cell C2. It will read =A2+B2. Cell C3
will read =A3+B3, and so on. This is known as Relative Reference.
More on this later.
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Example: To fill a sequence across, select cell Al and type "Mon", then select cell
Al. Place the Fat White Cross on the small black square so that it changes
into the Skinny Black Cross. Click and Drag to cell G1. The rest of the
days of the week will be filled into cells B1-G1.

Tip: You must select all of the cells that begin your sequence before you use
the Fill cursor. This will not work with all sequences but it will with a
number of them. Sometimes a single cell is enough for Excel to recognize
the pattern, but other times you need to give it more information.
Experiment!

3. The third cursor is the White Arrow: L\b This is the Moving Cursor. Placing the Fat
White Cross on the border of a selected cell or group of cells will change it into the
Moving Cursor. The Moving Cursor allows you to move the contents or formulas of
a cell or group of cells to another desired location. Select the desired cell or group of
cells. Place the Fat White Cross on the border of the selected cell or cells. Click and
Drag the cell or cells to the desired location. See example:
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Input and format data

Inputting data is as simple as selecting the cell in which you want to place the data, and
typing the data in. The Skinny Black Cross can be used to speed up the entry of data that
follows a pattern, and formulas (discussed below) can be used to calculate sums,
averages, etc.

Referring to cells

As discussed above, each cell has a unique address, consisting of its column letter and its
row number. Ranges of cells can be referred to using the following guidelines:
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To refer to Use
The cell in column A and row 10 Al10
The range of cells in column A and rows 10 through 20 A10:A20
The range of cells in row 15 and columns B through E B15:E15
All cells in row 5 5:5
All cells in rows 5 through 10 5:10
All cells in column H H:H
All cells in columns H through J H:J
The range of cells in columns A through E and rows 10 through 20 | Al0:E20

1. Relative reference: When you refer to cells as shown above, you are using what is
called a relative reference. For instance, if you select cell A3 and enter “=A1+A2”,
you are really telling Excel to add together the values in the two cells above the one
you have selected. If you copy this formula and paste it into cell B5, it will add
B3+B4. Both the column letters and the row numbers have changed! The same thing
happens if you use the Skinny Black Cross to fill the formula into other cells.

2. Absolute reference: If you instead want to copy or fill a formula into another cell
but still have it refer to the original values you specified, you need to place a $ sign
before each part of the cell addresses that you want to stay fixed. For instance,
“=3A$1+$A$2” means “add together the values found in cell Al and cell A2” no
matter which cell this formula gets copied into. “=$A1+$A2” keeps the column fixed
as an absolute reference, but allows the row number to be a relative reference.
Likewise, “=A$1+A3$2” keeps the row fixed, but allows the column to change.
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If you have a lot of data to enter, you may find that you have too many rows to fit on the
screen at one time, and your column headings have gotten pushed off the top of the
screen. To keep the column headings visible at all times, highlight the row just below
your column headings, then go to Window > Freeze Panes. This will "pin" the row
containing your column headings so that when you scroll down the screen, the row of
column headings stays put. To unpin this row, go to Window - Unfreeze Panes.

A Microsoft Excel - volcano report

J Fle Edit View Insert Format Tools Data | Window Help
]Dﬁﬂ‘é@.ﬂéﬁﬁ% Hide ﬁs%lil‘ﬂ.@wo% - @), | wid
Mo A =| Dahbahu, Ethio L7
B C_|
1 Most recent
| 2 |VOLCAHO: |T 1 valcano report significant
3 eruption
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acchrred gt Dabbahy. The correct report s below. & team of scientists visted the Da'lUre localty immediste
adjacent to the ME flank of the Guaternary Dabbahu (or Boing) felsic complex on 4 and 5 October after

receiving reports of volcanic activity there on 26 September. People in the ares noted that on 26 September st
ahout 1300 & very strong earthquake shook the area, and was followed by & dark column of "smoke” that
roze high into the atmosphere and spread out to form a cloud, which darkened the area for 3 days and 3
nights. The sciertists determined that & minor explosive eruption occurred from two semi-circular vents,
producing sshfall that was ~2 cm thick near the vent, Ash deposts extended more than 200 m from the vert.
Boulders emitted during the eruption were a3 large a2 3 m and were depostted a3 far a2 20 meters away,
The scientists noted intense degassing from the verts, the scent of sulfur dioxide, and the: sound of boiling
water inthe vents. Az of shout 10 October, the Addis Ahaba University Geophysical Ohservatory reported th

2004

™~ If you want to unpin
the column headings,
this option changes
to Unfreeze Panes.

Garbuna Group, Mew Britain, Papua MNew Guines

Ry 0 reported that an eruption began st Garbuna on the afternoon of 16 Cctober when "“white wapot” rose
ghove the volcano and & couple of felt earthouakes occurred, On 17 October, an eruption column rose 3-4 km
ghove the volcano's summit (oF 11,700-15,000 1t &.21). &t 1100 fine azh fell on the W and MY sides of the
volcano, covering two plantations. \Water sources originating from Garbuna were affected by the eruption.
According to RYO, the volcano last erupted shout 1,700 years ago.
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Merge Cells

Occasionally, you may want to put a title at the top of your worksheet. This title may be
considerably longer than the data in the columns below. Rather than having your title
force the data column below to be wider than you want, you can select two or more
adjacent cells and merge them into one large cell. Select the desired group of adjacent
cells. Then on the Formatting Menu Bar, select the Merge and Center button. See

icture below.
P Merge and Center button
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Formatting cells

Once the data has been entered, the appearance of the data can be formatted using the
Format menu. Select the cells to be formatted, then go to Format - Cells... to open the
Format Cells dialog box.

The first tab is the Number tab.

Thista gives you th ailty t

format, among other things, how

Murnber l Aligrment I Fonk ] Border ] Patterns ] Protection I .
S E— dates will be shown (05/24/2007
[General -] | Quiz1Score vs. May 24, 2007), how many
Mumber . - . .
Currency Decimal places: [z = decimal places will be included in
poeounting numbers, or whether you want
Fereentage negative money balances shown
Fraction with a minus sign, in parentheses,
Text or in red. Experiment to find out
Special .
Custarn =l other options.

oK | Cancel
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The next tab is the Alignment tab.

. B . Format Cells .
This tab is especially useful for dld
Column headlngS that may be Murmber AI l Fant I Border ] Patterns ] Protection I
considerably longer than the data U ELgE Orientation
" . i s .
within the column. By changing T—E;::r“:la = 5= .
the alignment, the column headings T .
- ical: € J—
can be placed at an angle, keeping ii;;:m 5 o [T
them from overlapping each other K3
or forcing the column to be =
Unnecessar”y W|de Texk control 0 3: Degrees
[ Wrap text
[ shrink ko fik
[ Merge cells
014 | Cancel

Sort and analyze data

Sorting and alphabetizing

There are two ways to sort or alphabetize the data you have entered. The quick way is to
use the buttons on the Standard toolbar. One sorts the data in ascending alphanumeric
order (numbers 0-9 first, then A through Z), and the other sorts in reverse order. Begin
by selecting either one cell of data or the first empty cell below a column of data, and
then use one of these buttons. Excel will sort all of the data based on the values in the
selected column. All of the cells in a given row will remain in the same row. This is
important, so that last names and first names remain properly paired up.

W= A2 E e - 2),

Sort Ascending Sort Descending

Note: If you select more than one cell, only the selected cells will be sorted, which may
result in data in one column getting separated from connected data in different
columns (for instance, last names might get alphabetized, but first names would
remain in the same order, so the last names and first names would no longer be
paired up properly).
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The other way to sort data takes a little y
more time, but offers more options. Sort E]@
Again, select one cell of data or the first
empty cell below a column. Then go to
Data - Sort.... A Sort dialog box

opens, which allows you to specify up to e o
three sorting criteria. The second and

Sork by

|Name ﬂ o+ Ascending
" Descending

i f* Ascendin
. . . iz 1 Score - Cf g
third sorting criteria are only used as | = * Descending
“tie-breakers”. For instance, if you are vz
alphabetizing a list of students by last It Tect Seore & ascending
name, you may have two students who P i m——

share the same last name. You could use My lisk has
the second sorting criteria to tell Excel to

* Header row (" Mo header row
put these students in order by their first
name, or by their date of birth, or by any aptioNs. .. [ ok | concel
other criteria you set. If your data X |
columns have column headings in the \V4
first row, check the appropriate box to Check the appropriate bullet to
ensure that the column headings don’t get indicate whether your data has a
mixed in with the data when you sort. header row or not.

Filtering data

Filters allow you to quickly isolate all data entries with a certain value, hiding the entries
that don’t match the criteria you choose. To turn on filters, go to Data > Filter >
AutoFilter. Each column heading now has a pull down menu that lists all of the filtering
options possible.

A B c D
1 'Hame *|0uiz 1 Score ﬂ{)uiz 2 Score ﬂUnit Test Score ﬂ,\
2 |Alvarez, Bobby 9 B 42
3 |Hopkins, Alicia 8 8 15 Pull down for
4 |Jones, Richard 7 ] 8 filtering options
5 |Markova, Matalya 7 10 47
6 |Simmaons, Dan a 7 47

The same data, filtered to show only those
students who scored 47 on the Unit Test.

A | B C D
1 Name | Quiz 1 Score w|Quiz 2 Score »|Unit Test Score |
5 |Markowa, Matalya 7 10 47
E |Simmaons, Dan a 7 47

10
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Use formulas and functions

Formulas and functions allow you to fill cells with values based on the data in other cells.
Some commonly used functions are Sum and Average, but there are many other options.
Both formulas and functions always begin with an equal sign. They can be entered in a
number of ways:

= Formulas and functions can be entered into a cell by first selecting the desired cell and
typing in the formula or function. After the formula has been entered you must press
enter to actually “place” the formula into the cell.

Example:

Example:

Example:

Click cell C1, type: =A1+B1 and then press enter. The formula is now in
cell C1. To test it, type in different values for cells A1 & B1, pressing enter
or one of the arrow keys to enter the number into the cell. The value in cell
C1 will automatically change so that it is equal to the sum of the values in
Al and B1.

Click cell B2, type: =A2*3 and then press enter. The formula is now in
cell B2. To test it, type in different values for cell A2, and press. The value
in cell B2 will automatically change so that it is three times the value in A2.

Click cell D4 and type: =average(A3:C3) and then press enter. To test it,
type in different values for cells A3, B3 & C3 and press enter. The value in
cell D3 will automatically change so that it is equal to the average of the
values in A3 through C3.

It is important to use the proper operator with the correct order of operations. The
parentheses symbols will help you accomplish this. When entering multiplication or
division operators you must use the asterisk key (*) for multiplication and the forward
slash key (/) for division. Also, please remember that there is a big difference
between a zero (0) and the letter O. Make sure that you use a zero in your formulas or
you will get a syntax error!

Note: To enter a range of adjacent cells, enter the first cell address, then a colon, and
then the last cell address. Every cell in between will be included. Al:A3 means

Al

, A2 and A3. Al:C3 means Al, A2, A3, B1, B2, B3, C1, C2, and C3!

11
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= |nstead of typing in the cell addresses referenced in your function or formula, you may

click on th

Example: Type numbers in cells Al, A2, and A3. In cell A4 type an

e appropriate cell.

sign. Then

with your mouse, click on cell A1, type a + sign, click on cell A2, type
another + sign, and finally click in cell A3 and press Enter. The sum will be
placed into cell A4. This has the exact same result as just typing

“=A1+A2+A3".

=[ =A1+A2+AT

B | ¢ | D

[ap] [SRE SN RE

= Cell addresses can also be entered into a formula or function by Clicking and
Dragging across the appropriate cells.

Example:

Type numbers into cells Al through A5. Select cell A6 and type: =sum(
Next, click and drag cells Al through A3. Release the mouse button, then
hold the Ctrl key down and click on cell A5. Then type a right parentheses
symbol. Your screen should look like the picture below:

COUNTIF

[=]'3¢ o =] =sum[al1:A3 A5)

A [ B [ ¢ [ D |
1 10
2 4
=N B
4 13
5 12
6 [=sum(A1-A3 A5)
7

When you press Enter, the function will disappear from cell A6 and be
replaced with the actual sum of the selected cells. When cell A6 is

selected, the function =sum(A1:A3,A5) will still appear in the Formula
bar at the top of the workbook.

= |f you do not know the function you want to use, you may find it by going to Insert >
Function... or by clicking the fx button. Depending on which version of Windows
you are using, the fx button may either be located on the Standard toolbar or to the left
of the formula bar at the top of the workbook.

indow ﬂelp’_\

e L~ )i

=)
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0 .00
B % 5 a0

File Edit ‘View Insert Format Toals
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Arial
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in some versions of Windows has a carrot drop down

menu that does a similar task to the fx button. At the bottom of the menu is
More Functions. This will bring up the same window as clicking on the fx

button does.)

Inserting a function using either the fx button or the Insert menu will open a dialog

box for the function you have selected.

| arial 0 RO EE EE e R E =
mEracE |7 X /| =| =AVERAGE(A1:A5)
A | B | ¢ [ o | E | F [ & | H ]|

Number 1 box

—
[

—
—

=
)

The exampl
are automat

|‘°|°°|“‘¥(|”‘|‘“|L”|”|*
=
S
&R

10
AYERAGE

1085 ] = 1o4iei19:12

}J\

= 10.2
Returns the average (arithmetic mean) of its arguments, which can be numbe%\

arrays, or references that contain numbers,
Number1: numberl,numberz,... are 1 to 30 numeric arguments for which vou wank

Number

urnberz I

T~

Collapse Box

the average.
Ok I

Formula result =10.2 Cancel |

e shown above is for the AVERAGE function. The cells to be averaged
ically by Excel entered into the Number 1 box. Check to make sure that

Excel included the cells you want. If you wished to include non-adjacent cells, you
can enter these in the Number 2 box. The Collapse Box shrinks the dialog box down
so that you can see your Excel workbook. This allows you to click and drag the cells
you want, holding the Ctrl key to select non-adjacent cells if desired. When you are
done, click on the Collapse Box again to re-expand the function dialog box.

AVERAGE

[=] X v =| ~AVERAGE(A2:A3.25)

fia}

[ B [ ¢ [ o [ E | F [ & [ H ] [ 1 [ K
[az:a3,85 E'I
Collanse Box
(A3 AB)
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= One other cool thing about Excel is on the Status bar at the bottom of the Workbook,
just above the Taskbar. If you select two or more cells with numerical data in them,
you can Right-click anywhere on the Status bar and it will give you a number of
options. Those options include Average, Count, Count Nums, Max, Min, and Sum
without having to enter a formula. See picture below:

. Microsoft Excel - Bookl = O] x|

ﬁ Fila Edit Wew Insett Format Tools Data Quickshest Window Help N =

NEH SRY (P BRS v @ = 4|7

| aria w0 s|BZzU E=E=EEH -5 A
=/ 10

Cec o e F 65

Mone J

Average
Count

0| [ o | S | Pt | i

Count Mums -

[4[4 [p[p]Sheet1 / Shestz 7 Sheets /  [Max | LU_‘

” Draw ~ [x (% | AutoShapes = ™. “a Mn oy - i - & o
|7§um

Status Bar sep Ready “_WT MMl

Right-clicking on the Status Bar
will bring up this sub-menu.

Charts and graphs

Creating a chart

To create graphs, first highlight the data you want to use for your graph. Next, find the
Chart Wizard button on the menu bar and click it:

E Microsoft Excel - Book1

I%] File  Edit  Yew Insert  Format  Tools  Data  Window  Help

RN BEWE NI WO <P WEEr- Rt A RN Womar s w1 | [ ) FLR Y |

Pl S P L) ey Ao |2 A g | e Replywith Changes..._End Revis,. ! Chart Wizard
A4 - e Dogs
s ¢ | o | E | F 16 | H [ g
1
2
3 |Favorite Pet
4 |Dogs 15
5 |Cats 7
E |Fish 3
¢ |Monkeys 2EI_
B |TOTAL 45
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The Chart Wizard will walk you through creating S EHEEaEAREERIE ald
a graph/chart. Your first choice is chart type. For e e

each general type, there are usually several sub- m m EEE
types. Select the type that will best display the are ‘

data you are presenting, and then click Next >. L m ol [

@ Doughnut

iy Radar

@ Surface

o Bubble v

Clustered Column, Compares values across
rategories.

This button allows you
to see a preview of what
your chart will look like

Press and Hold to Yiew Sample

:
—— The next page of the Wizard shows you a sample of what

. your graph looks like, and you can begin to make changes. If

- you need to change the range of your data, you may do that
" o - here. Check the difference between rows or columns. Pick
R the options that work best for you and then click Next. If you
e %z decide that you don’t like one of your earlier choices, notice
e O that there is a Back button that allows you to return to an

earlier page of the Wizard.

[Ceoncal | [ cpesr J[ oas ][ ran ]

The third page of the Wizard allows you to add a chart
title, name the X and Y-axes and remove the legend if it
doesn’t work with your graph. Check out the various

hart Wizard - Step 3 of 4 - Chart Options

H ES Axes Gridlines | Legend | Datalabels | Data Table
Chart title:

tabs for other options. Taking out the legend is under e Lo
the legend tab. Again, if you need to return to an earlier "
step in the Wizard, use the Back button. tehe 0 ot . —

Numnber of Students

Cancel H < Back “ [ext > ][ Finish
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Chart Lacation _ The final page of the Chart Wizard allows you to
Plce char: select where you will place your chart. You can
choose to have it on its own sheet in your Excel
workbook (on a separate tab at the bottom of the
workbook), or as an object in the current

worksheet. This choice doesn't really lock you
S into anything you can't change.

[ bdic ronatt facel - Booky

Zlow o8 e bt Pume Dmk Qe meke b
Jaid d ik 0Lk B, ik b sl e W LB I

Example of a chart
placed as an object in
the current page

v
Favoite Pats

[ —

=

Making changes to your chart

Once you have made your chart, you may decide that you want to make changes. Right
clicking on different areas of the chart will bring up menus of changes you can make.
Among the things you can click are:

the title
the chart area\ / gridlines

Favorite Pets
the plot area— | /

' the series
value axis . _ category axis
the legend (not shown) I =

Dogs Cats Fizh Morkeys

v

"

|

Fﬁ dents

A

Humber of
8

i

If you have a bar or column graph, clicking on the middle of a column will allow you to
modify the entire series of data. Clicking on the border of a single column will allow you
to modify just that data point (this way you can change the color of a single column, for
instance).
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Chart Options..., accessible when you right click on the Chart Area or Plot Area,
essentially lets you go back through the Wizard.

Copy and Paste a chart

You can copy and paste your chart wherever you wish (for example into a new Excel
sheet, a word document, a Power Point, or an email message). To do this, right click on
the Chart Area (the white space around the outside of the chart), and select Copy.

Once you have pasted the chart into a new location, you may not be able to make changes
to the chart, so it's a good idea to make any desired changes first.
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